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About 
 
Main > Help > About 
 
The About screen is for information purposes only and relates 1) the software name and 
version, 2) the copyright, and 3) the company name, address, website and telephone. 
 
To return to Main screen: 

• Click <OK> to return to Main screen. 
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Calibrate 
 
Main > Tools > Calibrate 
 
The Calibrate screen allows the user to calibrate the 3DM-DH.  Individual accelerometer 
and magnetometers may be calibrated as well as all accelerometers and magnetometers 
simultaneously.  Calibration gain and offset values are written into the on-board memory 
of each unit. 
 
To calibrate a unit: 
Carefully read and follow the directions contained in the 3DM-DH Users Manual before 
you attempt to calibrate the accelerometers and magnetometers of a 3DM-DH. The 
following instructions describe the steps you follow in the software only.  

• Click <Tools>. 
• Click <Calibrate>. 
• The Calibrate screen will appear. 
• Click <File>. 
• Click <Read>. 
• The application will begin continuous sampling of the accelerometer and 

magnetometer bits and will display these in the Current Bit frame. 
• Physically rotate the unit about its axes as described in the Users Manual. 
• Select (by clicking the checkboxes with your mouse) the accelerometer (Ax, Ay 

and/or Az) and/or the magnetometer (Mx, My and/or Mz) or All axes that you 
want to calibrate. 

• Click <File>. 
• Click <Write>. 
• You will receive a confirming message box. Click <OK>. 

 
To return to Main screen: 

• Click <File>. 
• Click <Return>. 
• Note: If you click <Return> without clicking <Write>, the current calibration on-

board the 3DM-DH will remain unchanged. 
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Communication Ports 
 
Main > File > Comm Port 
 
The Communication Ports screen allows the user to either select a specific serial port to 
connect to the 3DM-DH or to automatically detect (auto-detect) an existing 3DM-DH on 
any of the computer’s serial ports. 
 
Note: When the software is launched, the application automatically searches for a 
configuration file and if found, sets the serial port found in the configuration file as the 
default.  If this setting occurs, a check will appear next to the <Comm Port> menu item 
on the Main screen.  The configuration file is named ‘3DM-DHSettings.ini’ and is found 
in a sub-folder under the application directory named ‘Logs’. 
 
To specify a serial port: 

• Go to Main screen. 
• Click <File>. 
• Click <Comm Port>. 
• Using you mouse, click the “radio” button of the communications port where the 

3DM-DH is connected. 
• Click <OK>. The selected port will now be used for all communications between 

the computer and the 3DM-DH.  
• Note: You must select a communication port in order to proceed with the 

application. 
 
To auto-detect a 3DM-DH: 

• Go to Main screen. 
• Click <File>. 
• Click <Comm Port>.  The Communication Port screen will appear. 
• Click the <Auto Detect> button. 
• The software will poll each of the available serial ports on your computer and find 

any 3DM-DH that is connected to the computer.  If a 3DM-DH is found, the user 
will receive a message indicating ‘3DM-DH found on serial port X’.  At the same 
time the radio button of the communication port where the 3DM-DH was found 
will be clicked. 

• Click <OK> to set the communication port and return to the Main screen. 
• Note: If a 3DM-DH is not found on any of the computer’s available serial ports, 

the user will receive a message indicating ‘3DM-DH not found on serial ports 1-
4’.  If this occurs, a hardware problem exists either with the computer or the 
3DM-DH. 
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Configure 
 
Main > Tools > Configure 
 
The Configure screen allows the user to read and write certain settings maintained in 
memory on-board the 3DM-DH. These settings include filtering, tares, orientation, 
accelerometer gains and offsets, and magnetometer gains and offsets.  The settings are 
used to condition the 3DM-DH for particular situations and should only be changed after 
a thorough understanding of their effect on the device. 
 
Note: See the Using the Settings on the Configure Screen –Standard section of this Help 
file for details of each setting. 
 
To read settings: 

• Click <Tools>. 
• Click <Read>.  The program will retrieve the settings from the on-board memory 

of the 3DM-DH and display them. 
• Note: If a particular setting isn’t initialized on-board the 3DM-DH, a message 

box will appear indicating which address isn’t initialized. Note the address, click 
<OK> and the default value for that setting will be displayed.  Click <Show 
Addresses> under <Tools> to see which setting was defaulted. 

 
To write settings: 

• Click <Tools>. 
• Click <Write>.  The scroll boxes for each of the settings will become enabled. 
• Change particular settings by scrolling values up/down or by entering values 

through the keyboard. 
• Click <File>. 
• Click <Save>. You will be asked to confirm the Save. The new settings will be 

written to the on-board memory of the 3DM-DH and the screen will return to the 
Read state. 

• If you decide after changing settings to cancel the changes, click <File>, then 
<Cancel>. The new settings will NOT be written to the on-board memory of the 
3DM-DH and the screen will return to the Read state.  

 
To show addresses: 

• Click <Tools>. 
• Click <Show Addresses>.  The memory locations of the settings on-board the 

3DM-DH will be displayed. 
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Dials 
 
Main > Display > Dials 
 
The Dials screen allows the user to visualize an ANGLES data acquisition session 
through a “pitch” dial, a “yaw” dial and a “roll” dial.  The screen allows the user to start a 
session, record a session, stop a session and change to a different display. In addition this 
screen is also used to “tare the angles” of the 3DM-DH. 
 
To begin sampling a 3DM-DH: 

• Click <Data>. 
• Click <Sample>. A check will occur to the left of the menu item indicating 

sampling is in progress. 
• The application will begin sampling the 3DM-DH and will display the pitch, yaw 

and roll angles of the unit. 
 
To stop sampling a 3DM-DH: 

• Click <Data>. 
• Click <Sample>. The check to the left of the menu item will disappear indicating 

sampling has stopped. 
 
To save data to a file: 

• Click <Data>. 
• Click <Save>. 
• A “common dialog” box named Save As will appear. 
• You may create a new name for the data file in the File Name textbox and select a 

file type in the Save As Type textbox or you may select an existing file as the data 
file.  Click the Save button. The common dialog will disappear. 

• A check will now appear to the left of the <Save> menu item indicating that a file 
is in place to receive data anytime sampling is active.  

  
To stop saving data to a file: 

• Click <Data>. 
• Click <Save>.  The check to the left of the menu item will disappear indicating 

saving has stopped. 
 
To tare a unit: 

• Note: This function allows the user to “tare” (zero) a 3DM-DH.  This is useful in 
installations where the unit is placed in a position which introduces an angular 
offset into one or more of the unit’s axes. By “taring’ the unit, these offsets can be 
negated, thus rendering adjusted angular information during a data acquisition 
session. 

• Begin sampling the unit as described above. 
• Click <Tare>. 
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• The Set Tare frame will appear.  Values will appear for Pitch, Yaw and Roll 
which reflect the current tare values. Note: Tare values are maintained on-board 
the 3DM-DH and are read and applied during <Initialize Connection>. 

• To set any or all of the axes of the unit to the “artificial space” of your particular 
environment, move the 3DM-DH to the position you want and click either the 
Tare Pitch button and/or the Tare Yaw button and/or the Tare Roll button or the 
Tare All button. 

• The tare offsets are captured and immediately applied to all values coming from 
the unit during the session.  They will be discarded when the program is ended 
unless you write them to the 3DM-DH. 

• If you want the tare values written to the 3DM-DH’s internal memory for use in 
future sessions, click <Write Tares>.  Tares will be written to the on-board 
memory of the 3DM-DH and will be read and applied during subsequent 
<Initialize Connection>. 

• If you want to ‘zero’ all tares during a session, click <Zero All Tares> and no 
tares will be applied during the session.  This action doesn’t affect the tares 
written into the 3DM-DH’s internal memory. 

 
To change displays: 

• Click <Display>. 
• Click either <Dials> or <Gauges> or <Graph> or <Instruments>.  The selected 

display screen will appear for further use. 
 
To return to Main screen: 

• Click <Data>. 
• Click <Return>. 
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Gauges 
 
Main > Display > Gauges 
 
The Gauges screen allows the user to visualize a BITS data acquisition session through 
“vertical pointer slides”.  The screen allows the user to start a session, record a session, 
stop a session and change to a different display. 
 
To begin sampling a 3DM-DH: 

• Click <Data>. 
• Click <Sample>. A check will occur to the left of the menu item indicating 

sampling is in progress. 
• The application will begin sampling the 3DM-DH and will display the 

accelerometer axes (Ax, Ay and Az) bits and the magnetometer axes (Mx, My 
and Mz) bits. 

 
To stop sampling a 3DM-DH: 

• Click <Data>. 
• Click <Sample>. The check to the left of the menu item will disappear indicating 

sampling has stopped. 
 
To save data to a file: 

• Click <Data>. 
• Click <Save>. 
• A “common dialog” box named Save As will appear. 
• You may create a new name for the data file in the File Name textbox and select a 

file type in the Save As Type textbox or you may select an existing file as the data 
file.  Click the Save button. The common dialog will disappear. 

• A check will now appear to the left of the <Save> menu item indicating that a file 
is in place to receive data anytime sampling is active.  

  
To stop saving data to a file: 

• Click <Data>. 
• Click <Save>.  The check to the left of the menu item will disappear indicating 

saving has stopped. 
 
To change displays: 

• Click <Display>. 
• Click either <Dials> or <Gauges> or <Graph> or <Instruments>.  The selected 

display screen will appear for further use. 
 
To return to Main screen: 

• Click <Data>. 
• Click <Return>. 
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Graph 
 
Main > Display > Graph 
 
The Graph screen allows the user to visualize an ANGLES or BITS data acquisition 
session through a line graph.  The screen allows the user to start either an ANGLES or 
BITS session, record a session, stop a session and change to a different display. 
 
To begin sampling a 3DM-DH for ANGLES: 

• Click <Data>. 
• Click <Sample Angles>. A check will occur to the left of the menu item 

indicating sampling is in progress. 
• The application will begin sampling the 3DM-DH and will display the pitch, yaw 

and roll angles of the unit. 
 
To begin sampling a 3DM-DH for BITS: 

• Click <Data>. 
• Click <Sample Bits>. A check will occur to the left of the menu item indicating 

sampling is in progress. 
• The application will begin sampling the 3DM-DH and will display the 

accelerometer axes (Ax, Ay and Az) bits and the magnetometer axes (Mx, My 
and Mz) bits. 

 
To stop sampling a 3DM-DH for ANGLES: 

• Click <Data>. 
• Click <Sample Angles>. The check to the left of the menu item will disappear 

indicating sampling has stopped. 
 
To stop sampling a 3DM-DH for BITS: 

• Click <Data>. 
• Click <Sample Bits>. The check to the left of the menu item will disappear 

indicating sampling has stopped. 
 
To save ANGLES data to a file: 

• Click <Data>. 
• Click <Save Angles>. 
• A “common dialog” box named Save As will appear. 
• You may create a new name for the data file in the File Name textbox and select a 

file type in the Save As Type textbox or you may select an existing file as the data 
file.  Click the Save button. The common dialog will disappear. 

• A check will now appear to the left of the <Save Angles> menu item indicating 
that a file is in place to receive data anytime sampling is active.  

  
To save BITS data to a file: 

• Click <Data>. 
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• Click <Save Bits>. 
• A “common dialog” box named Save As will appear. 
• You may create a new name for the data file in the File Name textbox and select a 

file type in the Save As Type textbox or you may select an existing file as the data 
file.  Click the Save button. The common dialog will disappear. 

• A check will now appear to the left of the <Save Bits> menu item indicating that 
a file is in place to receive data anytime sampling is active. 

 
To stop saving ANGLES data to a file: 

• Click <Data>. 
• Click <Save Angles>.  The check to the left of the menu item will disappear 

indicating saving has stopped. 
 
To stop saving BITS data to a file: 

• Click <Data>. 
• Click <Save Bits>.  The check to the left of the menu item will disappear 

indicating saving has stopped. 
 
To change displays: 

• Click <Display>. 
• Click either <Dials> or <Gauges> or <Graph> or <Instruments>.  The selected 

display screen will appear for further use. 
 
To return to Main screen: 

• Click <Data>. 
• Click <Return>. 
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Instruments 
 
Main > Display > Instruments 
 
The Instruments screen allows the user to visualize an ANGLES data acquisition session 
through “horizon” and “heading” gauges.  The screen allows the user to start a session, 
record a session, stop a session and change to a different display. 
 
To begin sampling a 3DM-DH: 

• Click <Data>. 
• Click <Sample>. A check will occur to the left of the menu item indicating 

sampling is in progress. 
• The application will begin sampling the 3DM-DH and will display the pitch, yaw 

and roll angles of the unit. 
 
To stop sampling a 3DM-DH: 

• Click <Data>. 
• Click <Sample>. The check to the left of the menu item will disappear indicating 

sampling has stopped. 
 
To save data to a file: 

• Click <Data>. 
• Click <Save>. 
• A “common dialog” box named Save As will appear. 
• You may create a new name for the data file in the File Name textbox and select a 

file type in the Save As Type textbox or you may select an existing file as the data 
file.  Click the Save button. The common dialog will disappear. 

• A check will now appear to the left of the <Save> menu item indicating that a file 
is in place to receive data anytime sampling is active.  

  
To stop saving data to a file: 

• Click <Data>. 
• Click <Save>.  The check to the left of the menu item will disappear indicating 

saving has stopped. 
 
To change displays: 

• Click <Display>. 
• Click either <Dials> or <Gauges> or <Graph> or <Instruments>.  The selected 

display screen will appear for further use. 
 
To return to Main screen: 

• Click <Data>. 
• Click <Return>. 
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Main 
 

First screen on program launch 
 
The Main screen allows the user to navigate to all program functions including 
communication port selection, initialize connection, set mode, display angles or bits, 
configure, calibrate and program exit. 
 
To select a communications port: 

• Click <File>. 
• Click <Comm Port>.  Follow the instructions for Communication Ports screen 

given elsewhere in this Help file. 
 
To initialize connection: 

• Note: The Initialize Connection function is used to establish communication 
between the 3DM-DH and the host computer and to retrieve certain settings 
maintained in memory on-board the 3DM-DH including factory-set accelerometer 
gains and offsets, factory-set magnetometer gains and offsets, and pitch, roll and 
yaw tares. 

• If the program during launch detects a serial port setting in the configuration file 
(as described in Communication Ports elsewhere in this Help file), the <Initialize 
Connection> will run automatically. 

•  If successful, a message box will appear indicating initialization was successful 
and a check will appear beside the <Initialize Connection> menu item. 

• If unsuccessful, the mouse pointer will continue as an hourglass, and no success 
message will be generated. Initialization should occur within 5 seconds.  

• Note: If you are unable to initialize the unit, check your serial port connections, 
your cabling and your power supply for any obvious problems. Try initialization 
again by clicking <Initialize Connection>.  If you are still unable to initialize the 
connection, contact MicroStrain for support. 

 
To set mode: 

• Click <File>. 
• Click <Set Mode>.  Follow the instructions for Set Mode screen given elsewhere 

in this Help file. 
 
To display angles or bits: 

• Click <Display>. 
• Click either <Dials> or <Gauges> or <Graph> or <Instruments>.  The selected 

display screen will appear for further use.  Follow the instructions for the 
particular screen given elsewhere in this Help file. 

 
To configure: 

• Click <Tools>. 
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• Click <Configure>.  Follow the instructions for Configure screen given elsewhere 
in this Help file. 

 
To calibrate: 

• Click <Tools>. 
• Click <Calibrate>.  Follow the instructions for Calibrate screen given elsewhere 

in this Help file. 
 
To exit the program: 

• Click <File>. 
• Click <Exit>.  The program will terminate and communication between the 3DM-

DH and the host computer will cease. 
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Set Mode 
 
Main > File > Set Mode 
 
The Set Mode screen allows the user to configure the 3DM-DH so that it is operating in 1 
of 3 modes. The Continuous Angles Mode causes the 3DM-DH to output its angles data 
sets on a continuous basis.  The Continuous Bits Mode causes the 3DM-DH to output its 
bits data sets on a continuous basis.  The Polled Mode causes the 3DM-DH to only output 
a single data set when requested by the host computer. 
 
To select a mode: 

• Using your mouse, click the radio button of the mode of operation. 
• Click <OK>.  The 3DM-DH will be set to the mode selected, the Set Mode screen 

will disappear and you will be returned to the Main screen. 


